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 Configuring the GCS Web API Settings for encrypted communication. 
 Creating Web API Connection credentials. 
 Adding a signed SSL Certificate to the Web Server. 
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Introduction to the GCS Web API  

This guide covers how to install and set up the Web API for System Galaxy. 

System Galaxy’s Web API Interface supports both System Galaxy API Applications and 3rd-Party API Apps. This 
support includes Active Directory, LaunchPoint Web Client, Galaxy Mobile Apps, and idProducer Badging solution, 
3rd-Party Video Plug-in apps, 3rd-Party Elevator apps, and other 3rd-Party solutions.   

During the installation, System Galaxy (v11.8.6 or higher) automatically creates a reserved Web API Login, that is 
only used for fundamental API operations that are exclusive to the System Galaxy software.  This reserved Web API 
User Login should not be shared or used by any API apps or by 3rd-Party User Logins.  

All Galaxy API Apps and 3rd-Party API Apps must create their own SG Operator Login that is configured with the 
appropriate settings and permissions needed to support the operation of their application.   

 

FEATURED TOPICS …  

 Configure Web Services during the SG Software Installation 

 Creating a custom Web API User Account in SG Operator screen (if needed). 

 Configure Web API AppSettings file. 

 Configure SQL Server ConnectionStringsPDSA file 

 Configure SQL Server ConnectionStrings file 

 Obtaining a Certificate 

 Importing a Signed Certificate 

 Verifying the Certificate Key 

 Repairing a Missing Certificate Key  

 Capturing the Certificate Thumbprint 

 Adding the Certificate Thumbprint to the Batch File 

 Editing the Delete Certificate Batch file 

 Adding the Certificate to the Web API Service (SSL Setup batch file) 

(including Deleting an Expired Certificate) 

 

 

  



GCS-SG-SW-WEBAPI-0221  Page 4 of 17 

Configuring Web Services Settings during SG Installation 
During Part-3 of the System Galaxy software installation, the dealer can configure the port number(s) and Session Timeout 
for the Web Services.  If SG is already installed, these values can be changed in the appSettings config file. 

In SG 11.8.6 (or higher), SG Installer will silently create a reserved Web API User (“SGApiUser” & random password). The 
Web API User Login account is silently added to the SG database (operators table) and to appSettings config file. 

NOTICE: SG 11.8.5 (or older), the dealer could see and change the Web API User Login (name/password) in Web Services window.  

PREREQUISITES 
 You must have installed Steps 1 and 2 of the System Galaxy installation. 
 You should know the HTTP/HTTPS Port Number the customer wants to use for Web API connections. 
 Notice that an HTTPS Secure Socket requires the end-user to purchase/install an authentic Signed Certificate for the 

Web API Service. Galaxy recommends getting the longest certificate possible to avoid it expiring in only one year. 
Later sections of this guide cover how to obtain and install a signed certificate. 

STEPS 
1. During Part-3 of the System Galaxy software install, you will encounter the Web Services Settings screen.  

2. If you want to change the Web Settings, edit the following fields as needed … 
a) Set the appropriate Port Number in the HTTP or HTTPS field, as needed. 
b) Recommended to set the Session Timeout to “20” (default). Setting a “0” means no timeout. 
c) The reserved Web API User Login is no longer visible or programmable in this screen as of v11.8.6. 

NOTICE: SG 11.8.6 (or higher), the Web API User (“SGApiUser” & random password) is silently created and 
added to the SG database (system operator table).  In SG 11.8.5 or below, you must enter the username and 
password in this screen and then create the system operator account in System Galaxy software after the 
installation is completed.  The username and password are case-sensitive and must match exactly.   

 
 

3. Click Next to accept changes (or to keep the default settings) as desired.  

4. Click Finish to complete the installation.  
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Adding a API User Login (System Operator) for API-based Apps 

This topic describes how to add an API User Login for any 3rd-Party or proprietary API-based App (application).  
 

 

Do not use the reserved SGApiUser login to operate your 3rd-Party or proprietary API Apps. The SGApiUser 
login is exclusively reserved for System Galaxy internal operations. In SG 11.8.6 or higher the SGApiUser login and 
operator account are automatically created. In SG 11.8.5 or lower the installer must set the Username and 
Password during the installation and must manually create the User Account in the system operator screen.  

 

REQUIREMENTS 
• An SG system admin (master operator) is required to create User Logins (system operator accounts). 
• You must create a User Login (system operator) for your 3rd-Party or Proprietary API-Apps. 
• All User Logins (system operators) must have the correct operator permissions (privileges/filters) to support the features 

of the Proprietary and 3rd-Party API Apps ~ such as idProducer, LaunchPoint Client, LaunchPoint Mobile App, Active 
Directory, etc. 

 

STEPS 
To create a User Login account for your API-based application (app), you must create a system operator. 

1. From the SG Menu, click Configuration > System > System Operators 

2. Enter the Operator Name (case-sensitive): must be a valid email address in SG11.8.6 or higher. 

3. Enter a strong Password that contains each the following … 
• 8 characters long (minimum length) • Number character 
• Uppercase character • Do not use any special characters! 
• Lowercase character  

4. The ‘Master Operator’ checkbox does not need to be on for a User Login. 

5. The ‘Account Disabled’ checkbox should be unchecked. User Login must be active.  

6. The ‘No Filters’ checkbox should be unchecked if you are customizing the user permissions.  
• Checked = user permissions (operator privileges/filters) will be ignored. User will have permission to all. 
• Unchecked = user permissions (privileges and filter settings) will be applied. 

7. Set the ‘Password Never Expires’ checkbox as needed.  
• Checked = password will never expire 
• Unchecked = password will expire at midnight on the chosen date. 

8. Click Apply to save the operator account (click Yes to accept “no filters” if prompted). 
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Configure AppSettings Keys the GCS Web API  
The GCS Web API uses an appSettings config file to define the configurable keys for the Web API.  Several of the 
API-Based Applications rely on settings in this file that will permit or prevent their interoperation with the API.     

 

PREREQUISITES 
 If you are changing the name or password of the default Web API User login, then you will need to create a new SG 

Operator account (matching same username and password) in System Galaxy Operator screen.  
 (Best Practice) Before you make changes, make a backup copy of the appSettings file. 

STEPS 

1. In Windows Explorer, browse the GCS\System Galaxy\OptionalServices\WebServices folder. 

2. (Best Practice) Before you make changes, make a copy of the appSettings file for a backup copy. This way 
you have an unedited original copy that … 

• you can roll back to, if you need to undo changes … 
• you can review as an example, if you need to verify your syntax or correct mistakes made when you 

edited your working copy …   

3. Right-click the appSettings config file and choose to Edit in Notepad app. 

4. Edit only the value between the quotation marks (bold text)… 
 
<add key=”SGUserName” value=”SGApiUser” /> 
                     ( the default API Username is shown ) 

 Where “SGApiUser” is shown, you enter the exact same 
Operator Username you created for the WEB API operator.  

<add key=”SGPassword” value=”Password1”  />  Where “Password1” is shown, you must enter the exact same  
password you made when you created the WEB API operator. 

<add key=”UserSessionTimeout” value=”20”  />  The default value is 20 minutes.  
“0” means no timeout. 
You may increase this value as needed.  

<add key=”HTTPPort” value=”8000”  />  The default value is 8000.  
“0” (zero) will disable the HTTP port for the API. 
You can disable the HTTP port if you are using HTTPS. 

<add key=”HTTPSPort” value=”8443”  />  The default value is 0 (means port is disabled) 
“0” (zero) disables the HTTPS port for the API. 
You must set this to the HTTPS port number you will use. 
NOTICE: Using this port requires a signed certificate. 

  
 
Continue on the next page. 
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5. (conditional) IF you are using ASSA-DSR Readers, edit the following keys as shown (bold text)… 
 
<add key="AssaDsrEnabled" value="true" />  must be set to “true” to enable DSR operation 

(“false” is the default value)  

<add key="AssaDsrCallbackServiceEnabled" value="true" />  must be set to “true” to enable DSR callback operation 
(“false” is the default value) 

<add key=" AssaDsrCallbackOnHttps " value="false" />  should be set to “false” (default) 

<add key=" AssaDsrCallbackOnPort " value="9090" />  should set to desired port number 
(“9090” is the default value) 

<add key=" AssaDsrSyncUsersUseProxRawWherePossible " value="false" />  should be set to “false” (default) 

<add key=" AssaDsrCheckOnlineStatusIntervalMinutes " value="1" />  should be set to “1” (default) 

<add key=" AssaDsrPollLogEventsIntervalMinutes " value="1" />  should be set to “1” (default) 

<add key=" AssaDsrSyncUsersSchedulesAuthorizationsMinutes " value="1" />  should be set to “1” (default) 

 

6. (optional) You can edit the following keys as shown (bold text)… 
 

<add key="ThrottleLimit" value="0" />  default is 0 = no throttle limit (number of requests) 

<add key="ThrottleSwaggerLimit" value="100" />  default is 100 

<add key="ThrottleTimeIntervalSeconds" value="0" />  default is 0 = time interval in seconds between requests.  

7. Note that there are additional keys for LaunchPoint, idProducer, and ASSA-DSR which are not covered in 
this section.  

8. Save the file after changes are made and restart the GCS Web API Service to initiate new values. 
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Configure the ConnectionStringsPDSA file (for Web Service)  

The GCS Web API uses the ConnectionStringsPDSA config file to set the configurable connection string for the 
Web Service.  This allows the Web Service to connect to the System Galaxy database.     

IMPORTANT: If the database is moved or running on a different computer, you will need to edit the connection string 
(machine name) to match the true location. Also, if the database instance name was changed, you must 
also edit the instance name to match the new name. And if the client login credentials have been 
changed, you must update the User ID and Password to match the new login credentials. 

PREREQUISITES 

 You must have installed all 3 Steps of the System Galaxy software. 
 (Best Practice) Before you make changes, make a backup copy of the connectionSettingsPDSA file. 

 

STEPS 

1. Open the computer Services Window and stop the GCS WebAPI Service before editing the config file. 

2. On the computer where the GCS Web API Service is running, open the Windows Explorer and browse to 
the GCS\System Galaxy\OptionalServices\WebServices folder. 

3. Open and edit the connectionSettingsPDSA config file in Notepad app using Run as Administrator. 

4. In Notepad, you can turn on Word Wrap from the Format menu.  

5. Locate the connectionString field in the config file.  

• (if needed) Enter the machine name of the database server (i.e., the computer the database is running on).   

• (if needed) Enter the database instance name if the database instance name has been changed. 

6. (if needed) Enter the User ID and Password only if the client login credentials have been changed.  

7. Save your file changes and restart the Galaxy services.  
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Configure the ConnectionStrings file (for Web Service)  

The GCS Web API uses the ConnectionStrings file to set the configurable connection string for the Web Service.  
This allows the Web Service to connect to the System Galaxy database.     

IMPORTANT: If the database is moved or running on a different computer, you will need to edit the connection string 
(machine name) to match the true location. Also, if the database instance name was changed, you 
must also edit the instance name to match the new name. And if the client login credentials have been 
changed, you must update the User ID and Password to match the new login credentials. 

 

PREREQUISITES 

 You must have installed all 3 Steps of the System Galaxy software. 
 (Best Practice) Before you make changes, make a backup copy of the connectionStrings file. 

STEPS 

1. Open the computer Services Window and stop the GCS WebAPI Service before editing the config file. 

2. On the computer where the GCS Web API Service is running, open the Windows Explorer and browse to 
the GCS\System Galaxy\Configuration folder. 

3. Open and edit the connectionStrings file in Notepad app using Run as Administrator. 

4. In Notepad, you can turn on Word Wrap from the Format menu.  

5. Locate the connectionString field in the config file.  

• (if needed) Enter the machine name of the database server (i.e., the computer the database is running on).   

• (if needed) Enter the database instance name if the database instance name has been changed. 

6. (if needed) Enter the User ID and Password only if the client login credentials have been changed.  

7. Save your file changes and restart the Galaxy services.  
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Obtain & Import an SSL Certificate  
This section covers how to obtain, import, configure, and test the CSR Certificate. 

 

Obtaining an SSL Certificate  

The end-user should purchase an SSL Certificate as a part of the security measures in a live/production 
environment.  

 An SSL Certificate will encrypt the communications between the API-Based Apps and Web API Server.   
 The SSL Certificate will reside on the same computer where the GCS Web API Service is running. 

 

IMPORTANT NOTICES 

 Galaxy recommends you purchase the longest certificate lifespan possible. The API-Based Applications 
will stop working when the Certificate expires.  

 Self-signed certificates will not work in a live/production environment.  

 Galaxy makes no recommendations as to which brand will provide the best security or best value.     
 

PURCHASE AN SSL CERTIFICATE 

1. Identify Certificate Authority (CA), such as GoDaddy, Verisign, etc. to purchase a Signed SSL Certificate. The 
Certificate Authority will assist you in generating a Certificate Request CSR  

2. You must create the CSR Request on the same computer where the web services are installed/running.   

3. When the SSL Certificate is created, you will install it on the Web Server computer using the instructions in the 
following sections.  

 

 

IMPORTANT: Contact the Certificate Authority for technical support when submitting information to obtain the CSR and 
purchase an SSL certificate.   
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Import an SSL Certificate into the Certificate Store 

You must import the Signed SSL Certificate into the Certificate Store on the computer where the GCS Web API 
Service is running/residing. 
 

IMPORTANT NOTICES 

 Remember which branch/folder the SSL Certificate is imported into.  

 Galaxy recommends placing the Certificate in the Personal branch of the Certificate Store. 

 The SSL Setup Batch file will fail if there is not a private key on the Certificate. 
 

VERIFY THE PRIVACY KEY 
You must verify that a privacy “key” symbol is visible on the Certificate  after the Certificate has been imported into the 
Certificate Store.  

Run the certs.mmc file as an admin using the following steps.  

1. Click on the Windows Start button. 

2. In the Run field, type “mmc” and press <enter>. 

3. Right-click the mmc.exe file.  

4. Select Run as administrator. 

 

 

5. Under the Certificates branch, and open the folder where 
you imported the Certificate. Galaxy recommends the 
Personal folder.  

6. Double-click on the Certificate Name or icon  

The Certificate details window will open.  

 

7. On the bottom of the General tab, look for the private key 
symbol. 

a. If you have a privacy key, then go to the section to 
Capture the Cert Hash. 

b. If the is privacy key is missing, then you must 
generate the key. Go to the section to Repair the 
Certificate Key. 
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REPAIR THE MISSING CERTIFICATE KEY 

If there is not a key, then you must generate one. 

1. Select (click) the Details tab. 

2. Select (highlight) the Serial Number field in the upper 
List View. 

3. In the lower window, select (highlight) the number and 
copy it (Ctl+C)  - or write it down.  

 

 

 

4. Click on the windows Start button. 

5. Type cmd into the Run field. 

6. When a Windows Command Shell opens, type the 
following instruction, include the quotemarks (“ ”)  at 
the command prompt: 

certutil -repairstore my "SerialNumber" 

 

 

 

 

 

 

  

END OF REPAIRING A CERTIFICATE KEY 
 

  

 

WHERE  “SerialNumber”  REPRESENTS THE ENTIRE HEX 
NUMBER (INCLUDING THE QUOTE MARKS) THAT YOU 
OBTAINED FROM THE CERTIFICATE DETAILS IN THE 
PREVIOUS STEPS.  DO NOT INCLUDE ANY SPACES IN THE 

SERIAL NUMBER OR BETWEEN THE QUOTEMARKS. 
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Assigning the SSL Certificate to the Web API Server 
After the Signed SSL Certificate has been imported, you must assign the Certificate to the GCS Web API Service by 
running the SSL Setup batch file.  The batch file must be edited and configured with the Certificate Thumbprint string. 

 

CAPTURE THE CERTHASH (i.e., Thumbprint string)  

Run the certs.mmc file as an admin using the following steps.  

1. Click on the Windows Start button. 

2. In the Run field, type “mmc” and press <enter>. 

3. Right-click the mmc.exe file.  

4. Select Run as administrator. 

 

 

 

5. Click the File menu when the console window opens. 

6. Select Add/Remove Snap-in 

 

 

7. Select (highlight) the Certificates snap-in in the 
Available column on the left side. 

8. Click the [Add > ] button to move it to the right. 

 

 

Continue on the next page.  
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9. Choose Computer account option. 

10. Click [Next >] button. 

 

 
 

11. Click [Finish] button to accept local computer. 

 

 

 

12. Double-click on the Certificate Name or icon. 

13. Select (click) the Details tab. 

The Certificate details window will open. 

  

14. On the Details list, look for the Thumbprint field. 

The entire hex string will be displayed in the bottom 
window. 

 

15. Carefully write down the hex string.  

• DO NOT copy the leading space character.  
• Start with the first non-space character.  
• Do not include any spaces between the alpha-numeric 

characters.  

It is possible to copy the string to clipboard, but it 
may or may not be deemed secure to do so. 

16. Click OK to close this window. 

17. Go to the next section to add the cert hash. 
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COPY CERTHASH (Thumbprint) TO THE ‘SETUP_SSL’ BATCH FILE 

1. Locate the “setup_ssl.bat” batch file. 

THE SETUP SSL BATCH FILE IS LOCATED IN …  

(C:)GCS\System Galaxy\OptionalServices\WebServices\Utilities  

 

 

 

2. Right-click the setup_ssl.bat filename and select 
 EDIT from the context menu. Open in Notepad. 

 
 

3. Locate the “certhash” string in the batch file 
below the GCS.WebApi.WindowsService. 

4. Select (highlight) the existing hash string and 
replace it with the thumbprint string you copied 
from the Certificate Details tab. 

 Do not include any spaces! 

5. Remove the “rem” command on the line where 
the netsh command adds the cert hash.  

6. Also, if you are not using the default 8443 you 
must update/change the port number to the 
port you will use.  

7. Save the file and close it. 

 

 

 

In the example above the port number ‘8443’ has not been replaced. 
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RUN THE SSL SETUP BATCH FILE (Add the Certificate to the Web Service)  

IMPORTANT: if your prior Certificate expired, you must delete it before you add the new certificate to the Web 
Services.  The delete_ssl batch file can be used to delete the old certificate. Run as Administrator. 

 

1. Run the SSL Setup batch file by double-clicking it. 

A Windows command shell will open. 

 

2. Close the command window after you see the prompt 
“SSL Certificate successfully added”. 

“ 

3. Use the Swagger page to test the SSL Certificate. 

https://localhost:8443/swagger 

 

 

IF Operating System returns an error in the CMD Shell … 

IMPORTANT: If running the SSL Setup batch file returns an error, then 
you must remove the thumbprint by running the delete_ssl.bat file. 
Then rerun the SSL Setup file correctly.  

THE BATCH FILE IS LOCATED IN …  

(C:)GCS\System Galaxy\OptionalServices\WebServices\Utilities  

4. To delete and re-run the SSL Setup do the following...  

a) Double-click the delete_ssl.bat file to run it - this deletes 
your SSL certificate thumbprint. See Appendix for Editing 
the delete_ssl.bat before continuing to next step. 

b) Re-do Part 5.3.1: to verify your thumbprint hex string is 
accurate.  

c) Re-do Part 5.3.2: to edit the SSL Setup batch file, correct 
any errors to the port numbers or certhash. 

d) Re-do this Part 5.3.3 to add your SSL Certificate. 

 

“The parameter is incorrect.” 

Failed due to incorrect character in certhash in the SSL Setup file. 

 

 

“The syntax supplied for this command is not valid.” 

Failed due to spaces included in the certhash in SSL Setup file. 
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Appendix 
EDIT AND RUN THE DELETE_SSL BATCH FILE (for Expired Certificates, etc.) 

If you have one of the following issues, you may need to edit and run the delete_ssl.bat file … 

• you have an expired certificate  
• you encountered and Operating System error when running the ssl_setup-bat file in prior section   

Edit the delete_ssl.bat file ONLY IF you are using custom ports 
for the Web API connections.  (8443 is the default HTTPS Port) 

1. To edit the delete_ssl.bat file: navigate to the Web Services 
Utilities folder.   
(C:)GCS\System Galaxy\OptionalServices\WebServices\Utilities  

2. Right-click the filename of the delete_ssl.bat file and 
choose Edit from the shortcut menu. 

3. Open the delete_ssl.bat in Notepad. 

4. Where you see the HTTPS Ports (highlighted), carefully 
change the port to the port number the end-user has 
designated for the Web API.   

5. Select File and Save to save your changes. 

 

 

 

. 

 

Run the delete_ssl.bat file as follows … 

6. Right-click the delete_ssl.bat file to run it as Administrator. 

7. The batch file will run in a Windows Command Shell- this 
deletes your SSL certificate thumbprint.  

8. Return to the appropriate section to finish running the  
ssl_setup.bat (run as Administrator). 
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